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RINGKASAN

Pemetaan Tingkat Bahaya Erosi Menggunakan Universal Soil Loss Equation
(USLE) dan ArcGIS di Wilayah Administratif UPT PSDA Malang - Jawa
Timur; Rusdani Ashidiqi, 111710201035; 2015: 52 halaman; Jurusan Teknik
Pertanian Fakultas Teknologi Pertanian Universitas Jember

Erosi merupakan proses penghancuran, pengangkutan, dan pengendapan tanah

oleh pergerakan air yang menyebabkan hilangnya unsur hara tanaman dan

pendangkalan sungai. Fenomena erosi yang terjadi pada suatu daerah beragam

menurut ruang dan waktu. Keragaman erosi disebabkan kompleknya karakteristik

faktor-faktor erosi. Setiap faktor erosi mempunyai variasi yang komplek secara

spasial. Perbedaan ini sulit untuk diketahui apalagi dalam lingkup daerah yang luas.

Prediksi erosi diperlukan guna mengetahui laju erosi yang terjadi. Dengan

mengetahui hal tersebut, dapat memberikan informasi sebagai bahan pertimbangan

bagi pihak-pihak terkait dalam perencanaan lahan dan konservasi tanah.

USLE merupakan salah satu metode yang umum digunakan untuk memprediksi

rata-rata laju erosi jangka panjang pada suatu wilayah dari erosi lembar dan alur.

Beberapa parameter input USLE meliputi erosivitas hujan (R), erodibilitas tanah (K),

panjang dan kemiringan lereng (LS), indeks pengelolaan tanaman (C), dan tindakan

konseravasi tanah (P). Geographical Information System (GIS) merupakan alat yang

memfasilitasi penggunaan metode USLE dengan berbagai karakteristik faktor-faktor

erosi dalam skala spasial yang luas. Penelitian ini bertujuan a) memprediksi besar laju

erosi, b) mengklasifikasikan, dan c) membuat peta tingkat bahaya erosi.

Penelitian ini dilakukan di wilayah administratif UPT PSDA Malang, di Jawa

Timur. Total area yang dimodelkan yaitu sekitar 7.956,07 km2. Input data meliputi

data curah hujan tahunan (2001 – 2010) untuk menghitung faktor R, data nilai faktor

K, data DEM resolusi 30 m dari ASTER G-DEM untuk menghitung faktor LS, data

nilai faktor CP, peta sebaran stasiun hujan, peta jenis tanah, dan peta tataguna lahan.

Semua data diperoleh dari Laboratorium Teknik Pengendalian dan Konservasi
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Lingkungan, Jurusan Teknik Pertanian, Fakultas Teknologi pertanian, Universitas

Jember, kecuali data K dan CP yang mengacu pada nilai K dan CP di DAS Brantas.

ArcGIS 10.0 merupakan software GIS yang digunakan untuk pemrosesan data untuk

analisis erosi.

Hasil penilitian menunjukkan bahwa total laju erosi yaitu 27,17 ton/ha/tahun atau

setara 2,26 mm/tahun. Klasifikasi tingkat bahaya erosi mencakup lima kelas yang

terjadi pada wilayah studi antara lain: sangat ringan (1,85 ton/ha/tahun), ringan (33,76

ton/ha/tahun), sedang (103,47 ton/ha/tahun), berat (282,70 ton/ha/tahun), dan sangat

berat (1.379 ton/ha/tahun). Berdasarkan tingkat bahaya erosi yang terjadi, wilayah

penelitian didominasi oleh tingkat bahaya erosi kelas ringan (70,28% ), diikuti kelas

ringan (19,37%), sedang (8,21%), berat (1,70%), dan sangat berat (0,44%).
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SUMMARY

Soil Erosion Mapping Using Universal Soil Loss Equation (USLE) and
ArcGIS at Administrative Area of UPT PSDA Malang, East Java; Rusdani
Ashidiqi, 111710201035; 2015: 52 pages; Department of Agricultural
Engineering, Faculty of Agricultural Technology, Jember University

Erosion is the process of detachment, transportation, and sedimentation of
soil by the water movement which causes the lost nutrient in plant and the
sediment rivers. The phenomenon of erosion that occurs in a area is various by
the time and space. The variability of erosion due to complexity of the
characteristic erosion factors. Each erosion factors varies spatially. This
variation is more likely to be larger for wider area. Erosion prediction is needed
to know the erosion rate. By knowing predicted erosion, it can provide
information which, then this can be a very useful information for management and
soil conservation practices.

USLE is one of the methods generally used to predict the erosion rate in
long period in area of sheet and rill erosion. Some input parameters for USLE
include rain erosivity (R), soil erodibility (K), length and slope of topography
(LS), crop management index (C), and soil conservation practice (P).
Geographical Information System (GIS) is a device which has a strong potential
to facilitate the use of USLE method with multiple characteristics of erosion
factor in large spatial scale. The aims of the research were a) predicting the
erosion rate, b) classifying, and c) making the map of the erosion hazard raster-
based with resolution 30 m.

This research was conducted at the administrative area of UPT PSDA
Malang in East Java Province. Total area modeled was about 7,956.07 km2. The
data input included the annual rainfall data (2001-2010) which were to determine
the R-factor, the value data of K-factor, Digital Elevation Model (DEM)
resolution 30 m from ASTER G-DEM which were used to determine LS-factor,
the value data of CP-factor, the map of rainfall station, the type of soil map, and
the map of land use. All data are obtained from The Laboratory of Environment
Control and Conservation, Department of Agricultural Engineering, Faculty of
Agricultural Technology, Jember University, except the K and CP data which
was obtained from the values of available data of K and CP in Brantas watershed.
ArcGIS 10,0 is a GIS software used as data processing for analyzing of erosion
(soil loss).

The result of research shows that the total erosion rate is 27.17 ton.ha-

1.year-1 or equal to 2.26 mm/year. The results showed that there were five classes
of erosion hazard occurred in the study area: very low (1.85 ton.ha-1.year-1), low
(33.76 ton.ha-1.year-1), moderate (103.47 ton.ha-1.year-1), high (282.70 ton.ha-

1.year-1), and very high (1,379 ton.ha-1.year-1). Considering the areas of the
classes of erosion occurred, the research area was dominated by very low class of
erosion (70.28%), followed by low (19,37%), moderate (8,21%), high (1,70%),
and very high (0,44%).
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BAB 1. PENDAHULUAN

1.1 Latar Belakang

Erosi merupakan proses penghancuran agregat-agregat tanah menjadi

partikel-partikel tanah oleh pergerakan air atau angin kemudian akan diangkut dan

dibawa dan diendapkan pada daerah lain. Erosi menyebabkan lapisan tanah akan

terkikis kemudian mengendap sehingga menyebabkan pendangkalan sungai. Pada

tempat terjadinya erosi, erosi menyebabkan hilangnya unsur hara yang bermanfaat

bagi kesuburan tanah sehingga produktivitas tanah menurun. Produktivitas tanah

menurun mengindikasikan bahwa daerah tersebut dikatakan sebagai lahan kritis.

Secara umum, bentuk erosi ada dua macam yaitu erosi alamiah dan erosi

dipercepat. Erosi alamiah yaitu erosi yang terjadi secara alamiah oleh faktor alam

yang meliputi faktor iklim terutama curah hujan tinggi, jenis tanah berkaitan

dengan kepekaan tanah terhadap erosi, vegetasi penutup lahan, dan kondisi

topografi erat kaitannya dengan kemiringan dan panjang lereng suatu wilayah.

Erosi dipercepat merupakan erosi yang erat kaitannya dengan aktivitas manusia

yaitu tindakan konservasi tanah. Pengelolaan tataguna lahan seperti penebangan

hutan untuk perluasan lahan pertanian dan perkebunan, pemukiman baru tanpa

adanya pengaturan atau upaya konservasi akan mempercepat terjadinya erosi.

Dari uraian di atas, secara umum erosi disebabkan oleh lima faktor yaitu curah

hujan, jenis tanah, panjang dan kemiringan lereng, dan pengelolaan tataguna lahan

dan tindakan konservasi tanah.

Fenomena erosi yang terjadi pada suatu daerah beragam menurut ruang dan

waktu. Belum tentu erosi yang terjadi pada suatu daerah jumlahnya sama dan

terjadi dalam waktu yang sama. Keragaman erosi disebabkan kompleknya

karakteristik faktor-faktor erosi. Setiap faktor erosi mempunyai variasi yang

komplek secara spasial. Perbedaan ini sulit untuk diketahui apalagi dalam lingkup

daerah yang luas.
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2

Unit Pelaksana Teknis Pengelola Sumber Daya Air (UPT PSDA) Malang

merupakan salah satu dari sembilan PSDA yang ada di Provinsi Jawa Timur.

Wilayah UPT PSDA Malang meliputi empat kabupaten dan tiga kota yaitu

Kabupaten Malang, Blitar, Tulunggangung Trenggalek dan Kota Malang, Batu,

dan Blitar. Berdasarkan catatan BNPB, UPT PSDA Malang merupakan wilayah

yang rawan terhadap bencana banjir dan tanah longsor. Pada periode waktu 2000-

2010 telah terjadi bencana banjir dan tanah longsor sebanyak 10 kali yaitu

meliputi Kabupaten Malang, Tulungagung, Trenggalek, dan Kota Batu dengan

kejadian terbesar pada tanggal 19 April 2006 di Kabupaten Trenggalek dengan

korban meninggal 18 orang. Sedangkan untuk bencana tanah longsor, tercatat 32

kali kejadian di seluruh wilayah UPT PSDA Malang dengan berbagai macam

tingkat kerusakan yang ditimbulkan termasuk korban jiwa.

Arsyad (2012:53) menyatakan bahwa longsor merupakan pergerakan volume

tanah dalam jumlah yang relatif besar dalam waktu yang bersamaan karena dua

kondisi yaitu tanah jenuh air dan kemiringan lereng yang cukup curam.

Terjadinya longsor diawali oleh lapisan tanah jenuh terhadap air. Pada kondisi

tersebut, tanah sudah tidak mampu menyerap air karena pori-pori tanah telah

penuh dengan air dan atau partikel-partikel tanah yang umumnya merupakan hasil

erosi lembar dan alur yang terjadi secara berkesinambungan. Dengan demikian,

erosi lembar dan alur secara tidak langsung merupakan penyebab terjadinya

longsor. Oleh karena itu, sangat penting untuk menduga laju erosi tersebut sebagai

salah satu upaya pencegahan dalam mengurangi laju erosi.

Prediksi tingkat bahaya erosi diperlukan sebagai salah satu usaha untuk

mengetahui besar laju dan tingkat bahaya erosi. Dengan adanya informasi tersebut

dapat digunakan untuk menentukan tindakan yang akan dilakukan dalam upaya

mengurangi laju dan dampak erosi. Metode yang dapat digunakan untuk prediksi

erosi adalah Universal Soil Loss Equation (USLE). Metode ini dipilih karena

banyak digunakan secara umum dan diterapkan pada daerah tropis yang faktor

utama penyebab erosinya adalah air hujan. Menurut Arsyad (2012:360), metode

USLE merupakan metode yang dirancang untuk memprediksi laju rata-rata erosi

jangka panjang pada suatu bidang tanah dari erosi lembar dan erosi alur.
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Geographical Information System (GIS) merupakan alat yang memfasilitasi

penggunaan USLE untuk memprediksi erosi dalam skala spasial. (Parveen dan

Kumar, 2012:1; Oliviera et al., 2012:139). Aplikasi GIS memudahkan dalam

pengolahan data yang beragam secara spasial dengan berbagai input data yang

komplek. Dalam konsep GIS, GIS membagi daerah yang sangat luas ke dalam

suatu sel grid yang sederhana (Jain dan Kothyari, 2000:772). Perpaduan atau

integrasi antara konsep USLE dan GIS akan memudahkan dan sesuai untuk

memprediksi erosi dalam skala spasial yang cukup luas.

1.2 Rumusan Masalah

Pemanfaatan tataguna lahan yang tidak memperhatikan tindakan konservasi

seperti penebangan hutan secara liar menyebabkan lahan terbuka. Ketika hujan,

butiran hujan akan langsung menghantam tanah. Akibatnya, lapisan tanah atas dan

agregat tanah akan hancur dan terkikis. Jika hujan berlangsung terus menerus,

akan terjadi aliran limpasan. Air limpasan ini akan terkonsentrasi dan membawa

kikisan tanah menuju ke suatu badan air dan akan mengendap nantinya pada

tempat lain.

Permasalahan yang ada yaitu kurangnya informasi mengenai besar laju erosi.

Selain itu, belum tersedianya peta tingkat bahaya erosi pada wilayah penelitian.

Oleh karena itu, perlu dilakukan penelitian untuk memprediksi besar erosi guna

memberikan informasi sebagai bahan pertimbangan dalam tindakan konservasi

tanah.

1.3 Batasan Masalah

Penelitian ini menggunakan metode USLE yang diintegrasikan dengan

software ArcGIS untuk mengetahui besar laju erosi dan tingkat bahaya erosi

wilayah penelitian. Input data yang dibutuhkan berupa data curah hujan, peta jenis

tanah, peta tataguna lahan, dan data DEM.
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1.4 Tujuan

1. Memprediksi besarnya laju erosi;

2. Mengklasifikasikan tingkat bahaya erosi;

3. Menentukan luas tingkat bahaya erosi terbesar dan terkecil.

1.5 Manfaat

1. Dapat memberikan informasi mengenai besarnya laju erosi yang terjadi

dan klasifikasi tingkat bahaya erosi;

2. Dapat mengetahui luas tingkat bahaya erosi terbesar dan terkecil

3. Sebagai bahan pertimbangan bagi pihak-pihak terkait dalam perencanaan

penggunaan lahan dan konservasi tanah.
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BAB 2. TINJAUAN PUSTAKA

2.1 Terminologi dan Karakteristik Erosi

Erosi merupakan proses terkikisnya dan terangkutnya tanah dari suatu bidang

tanah dari satu tempat ke tempat lain yang disebabkan oleh pergerakan air dan

angin. (Arsyad, 2012:50). Tanah yang terkikis akan terangkut dan terbawa oleh air

dan angin kemudian diendapkan pada suatu tempat. Pada daerah yang beriklim

basah erosi yang terjadi umumnya disebabkan oleh hujan. Kikisan tanah akan

terlarut kemudian terangkut oleh air limpasan hujan menuju saluran sungai dan

akan diendapkan pada daerah yang lebih rendah.

Arsyad (2012:102) menyatakan, ada lima faktor penyebab terjadinya erosi,

antara lain: (1) iklim; (2) topografi; (3) vegetasi; (4) tanah, dan; (5) manusia.

Faktor iklim merupakan faktor yang berkaitan dengan hujan. Besar hujan,

intensitas, dan distribusi hujan menentukan kekuatan dispersi hujan terhadap

tanah, jumlah kecepatan aliran permukaan, dan kerusakan erosi. Faktor topografi

akan berpengaruh memperbesar laju aliran permukaan, semakin curam atau

miring lereng akan memperbesar energi angkut air terhadap partikel-partikel tanah

yang telah terdispersi atau terkikis.

Selain faktor iklim dan topografi, panjang dan kemiringan lereng berpengaruh

terhadap erosi. Panjang lereng menentukan kecepatan aliran air yang mengalir ke

permukaan tanah. Semakin banyak air yang mengalir maka semakin besar

kecepatan aliran di bagian bawah lereng daripada di bagian atas lereng. Vegetasi

merupakan lapisan pelindung atau penutup tanah yang berguna memperkecil

pengaruh daya rusak air hujan dan topogarfi terhadap erosi. (Arzi, 2012:10).

Kepekaan tanah berkaitan dengan karakteristik fisik dan interaksi kimia

tanah. Sifat tanah yang mempengaruhi erosi mencakup (1) sifat-sifat tanah yang

mempengaruhi laju infiltrasi, permeabilitas dan kapasitas tanah menahan air, dan

(2) sifat-sifat yang mempengaruhi ketahanan dan strukutur tanah terhadap dispersi

dan pengikisan oleh butir-butir hujan yang jatuh dan aliran permukaan. Aktivitas-

aktivitas manusia salah satunya yaitu pengelolaan tanah menjadi faktor yang
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penting dalam menentukan proses erosi. Kesalahan dalam pengelolaan tanah akan

meningkatkan peluang terjadinya erosi.

Utomo (1989:30) menyatakan bahwa proses terjadinya erosi dibagai ke dalam

tiga proses secara berurutan, yaitu: (1) pengahancuran agregat-agregat tanah; (2)

pengangkutan atau penghanyutan partikel-partikel tanah, dan; (3) pengendapan

pertikel-partikel pada suatu tempat.

Ada dua macam jenis erosi menurut Arsyad (2012:51) dan Kartasapoetra et al.

(2000:35-36) yaitu geological erosion atau normal dan accelerated erosion atau

erosi dipercepat. Dari kedua jenis erosi tersebut, erosi dipercepat sering menjadi

fokus perhatian dalam upaya konservasi tanah karena selain faktor alam, faktor

manusia erat kaitannya dengan terjadinya erosi ini. Oleh karena itu, maka perlu

dijelaskan mengenai bentuk-bentuk erosi dipercepat. Menurut Arsyad (2012:51)

dan Kartasapoetra et al. (2000:48), ada beberapa  bentuk erosi yaitu: (1) sheet

erosion atau erosi lembar; (2) rill erosion atau erosi alur; (3) gully erosion atau

erosi parit; (4) stream bank erosion atau erosi tebing sungai; (5) landslide atau

longsor, dan; (6) internal erosi atau erosi internal.

2.2 Prediksi Laju Erosi dengan Metode USLE

Prediksi erosi merupakan suatu metode untuk memperkirakan laju erosi yang

akan terjadi pada suatu lahan. Prediksi erosi dipandang sebagai metode yang

efektif dalam menduga erosi daripada melakukan perhitungan erosi secara

langsung di lapang. Hal ini dikarenakan dalam memprediksi erosi, proses yang

dilakukan tidak membutuhkan waktu yang lama. Selain itu, proses yang dilakukan

hanya perlu melakukan pengumpulan dan pengolahan data-data yang relevan.

Hasil prediksi dapat digunakan dalam jangka yang panjang. Jika ada perubahan,

lebih cepat untuk diupdate atau disesuaikan dengan perubahan-perubahan yang

baru. Prediksi erosi bermanfaat memperkirakan laju erosi yang nantinya dapat

digunakan sebagai pertimbangan dalam menentukan kebijakan penggunaan tanah

dalam upaya konservasi lahan. (Oliviera et al., 2012:140).
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Wischmeier dan Smith (1978:2-3) menyatakan bahwa USLE merupakan

model yang digunakan untuk memprediksi rata-rata laju erosi pada suatu wilayah

dan dapat digunakan pada lahan nonpertanian dan bangunan. Selain itu, USLE

tidak dapat menghitung pengendapan dan sedimen dari hasil erosi. Menurut

Parveen dan Kumar (2012:1), USLE merupakan model empiris yang paling

umum digunakan untuk prediksi dan kontrol erosi. Sedangkan menurut Arsyad

(2012:360), metode USLE dirancang untuk memprediksi erosi rata-rata dalam

jangka panjang dari erosi lembar atau erosi alur.

Metode USLE dalam aplikasinya menggunakan enam faktor. Faktor-faktor

tersebut yaitu erosivitas hujan (R), erodibilitas tanah (K), topografi yaitu panjang

dan kemringan lereng (L dan S), vegetasi penutup lahan dan pengelolaan tanaman

(C), tindakan khusus konservasi tanah (P). Secara matematis model USLE

dirumuskan dalam persamaan 2.1. (Wischmeier dan Smith, 1978:4)

A = R × K × L x S × C × P......................................................................... (2.1)

Keterangan:

A : Laju erosi tanah (ton/tahun)

R : Erosivitas curah hujan rata-rata per tahun (MJ.mm/tahun)

K : Faktor erodibiltas tanah (ton/MJ.mm)

LS: Faktor kemiringan dan panjang lereng

C : Faktor pengelolaan tanaman

P : Faktor tindakan konservasi

* Sedangkan untuk mencari laju erosi dalam satuan ton/ha/tahun, laju erosi
dibagi dengan satuan luas (ha)

2.2.1 Erosivitas Hujan (R)

Faktor erosivitas hujan dan limpasan permukaan, yakni jumlah satuan indeks

erosi hujan, dalam MJ.mm/tahun. Nilai erosivitas hujan dapat dihitung

berdasarkan data hujan yang diperoleh dari penakar hujan otomatik atau penakar

hujan biasa. Tingkat erosivitas hujan dapat dihitung dengan persamaan Bols

(Cooper, 2011:8; Teh et al., 2011:318).
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R = ,( , , )............................................................................ (2.2)

Keterangan:

R : indeks erosivitas rata-rata per tahun (MJ.mm/tahun)

P : curah hujan rata-rata tahunan (mm/tahun)

2.2.2 Erodibilitas Tanah (K)

Faktor K yaitu laju erosi per indeks R untuk suatu tanah yang diperoleh dari

petak percobaan yang panjangnya 22,13 m dengan kemiringan seragam sebesar

9% tanpa tanaman, ton/MJ.mm. Faktor K menunjukkan kepekaan tanah terhadap

erosi yang diformulasikan dalam bentuk nilai atau angka. Tabel 2.1 merupakan

nilai K beberapa jenis tanah di DAS Brantas. (Bappenas 2012:12)

Tabel 2.1 Nilai K berdasarkan jenis tanah di DAS Brantas

No Jenis Tanah Nilai K Tingkat Erodibiltas

1 Aluvial 0,29 Sedang
2 Andosol 0,28 Sedang
3 Brown Forest 0,28 Sedang
4 Glei 0,29 Sedang
5 Grumosol 0,16 Rendah
6 Latosol 0,26 Sedang
7 Litosol 0,13 Rendah
8 Mediteran 0,16 Rendah
9 Organosol 0,29 Sedang
10 Podsol Merah 0,20 Rendah
11 Regosol 0,31 Agak tinggi
12 NCB Soil 0,20 Rendah

(Sumber:Arsyad, 2012:143; Atasoy dan Ozahim,
2013:734 ; Bappenas 2012:12)
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2.2.3 Panjang dan Kemiringan Lereng (LS)

Faktor panjang dan kemiringan lereng, yaitu perbandingan antara besarnya

erosi per indeks erosi dari suatu lahan dengan panjang dan kemiringan lahan

tertentu terhadap besarnya erosi dari plot lahan percobaan, tidak berdimensi.

Kemiringan lereng biasa dinyatakan dalam derajat atau persen (Arsyad,

2012:112). Perhitungan faktor LS menurut Moore dan Burch (1986) mengikuti

persamaan:

LS = (X × CZ /22,13) , × (sin θ/0,0896) , .............................. (2.3)

Keterangan:

LS : Faktor lereng

X : Akumulasi aliran

CZ : Ukuran pixel

: Kemiringan lereng (ᵒ)

Menurut Rahim (2000:73) klasifikasi kemiringan lereng dibagi ke dalam

tujuh kelas seperti Tabel 2.2 berikut ini.

Tabel 2.2 Klasifikasi kemiringan lereng

No Klasifikasi (%) Kondisi

1 0 – 3 Datar

2 3 – 8 Landai

3 8 – 15 Bergelombang

4 15 – 30 Miring berbukit

5 30 – 45 Agak curam

6 45 – 65 Curam

7 > 65 Sangat curam

(Sumber: Rahim, 2000:73)
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2.2.4 Indeks Tanaman (C)

Arsyad (2012:366) menyatakan bahwa faktor tanaman penutup lahan dan

manajemen tanaman, yaitu perbandingan antara besarnya erosi dari suatu lahan

dengan penutup tanaman dengan manajemen tanaman tertentu terhadap lahan

yang identik tanpa tanaman, tidak berdimensi.

2.2.5 Tindakan Konservasi Tanah (P)

Faktor P merupakan tindakan konservasi tanah yaitu perbandingan besarnya

erosi dari lahan dengan tindakan konservasi khusus seperti pengolahan tanah

menurut kontur dalam strip atau teras terhadap besarnya erosi pada tanah yang

diolah searah lereng dalam keadaan identik, tidak berdimensi. (Arsyad, 2012:369)

2.3 Tingkat Bahaya Erosi

Menurut Wischmeier dan Smith (1978:2), tingkat bahaya erosi ditentukan

berdasarkan perbandingan antara besarnya erosi aktual dan erosi tanah yang

ditoleransi. Erosi yang ditoleransi yang dimaksud merupakan batasan-batasan

jumlah tanah yang tererosi (ton/ha/tahun). Dalam Peraturan Menteri Kehutanan

No. P.32/MENHUT-II/2009, tingkat bahaya erosi diklasifikasikan dalam lima

kelas seperti yang disajikan pada Tabel 2.3. Klasifikasi tersebut akan memberikan

gambaran tingkatan erosi yang terjadi sehingga dapat dijadikan pedoman dalam

perencanaan pengelolaan tanah selanjutnya.

Tabel 2.3 Klasifikasi tingkat bahaya erosi

Kelas Bahaya Erosi Laju Erosi

(ton/ha/tahun)

Keterangan

I <15 sangat ringan

II 15 – 60 Ringan

III 60 – 180 Sedang

IV 180 – 480 Berat

V >480 sangat berat

(Sumber: Menteri Kehutanan, 2009:52)
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2.4 Integrasi GIS dan USLE

GIS secara sederhana diartikan sebagai software pemetaan terkomputerisasi.

Sedangkan secara formal, GIS merupakan sistem pengelolaan database dengan

memanfaatkan komputer untuk menangkap,  menyimpan, menerima, mengelola,

menganalisis, dan menampilkan data spasial, misalnya lokasi atau bentuk

permukaan bumi. Layer GIS tersusun oleh beberapa layer informasi spasial yang

tergeoreferensi dalam sistem koordinat. Dalam pemodelan GIS terdapat dua data

yaitu data vektor dan data raster. Menurut Indarto dan Faisol (2012:18), data

vektor merupakan data yang menggambarkan objek atau fenomena geografis

dengan menggunakan point (titik), line (garis), dan polygone (polygon).

Sedangkan data raster merupakan data yang menggambarkan objek atau fenomena

geografis dalam bentuk cell, grid, atau piksel. Setiap piksel merupakan persegi

sama sisi dengan satuan luas tertentu (misal m2, km2, ha, dan sebagainya)

Menurut Okoth (2014:79), GIS menggabungkan fungsi analisis spasial untuk

menyebarkan dan atau menyalurkan data. Software GIS menyediakan mekanisme

pengolahan data untuk menghasilkan output. Model USLE untuk prediksi tingkat

bahaya erosi melibatkan seluruh proses data yang berkaitan dengan faktor-faktor

erosi melalui software GIS seperti RUSLE Science Software, Quantum GIS,

Global Mapper, Arc View, ArcGIS, dan lain sebagainya. Dalam proses prediksi

erosi dengan integrasi GIS dan USLE, data ketinggian, karakteristik tanah,

vegetasi penutup tanah, tindakan konservasi tanah, dan curah hujan harus diproses

terlebih dulu melalui software GIS untuk menghasilkan data berbentuk vektor dan

raster. Hal tersebut merupakan catatan penting karena GIS berperan sebagai

bagian yang harus dilengkapi dalam prediksi tingkat bahaya erosi.
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BAB 3. METODOLOGI PENELITIAN

3.1 Tempat dan Waktu Penelitian

Penelitian ini dilaksanakan pada bulan Mei sampai Oktober 2015 di

Laboratorium Teknik Pengendalian dan Konservasi Lingkungan, Jurusan Teknik

Pertanian, Fakultas Teknologi Pertanian, Universitas Jember.

3.1.1 Daerah Studi

Daerah studi yang diamati dalam penelitian ini adalah wilayah administratif

UPT PSDA Malang Provinsi Jawa Timur. Daerah studi ini seluas 7.956,07 km2

atau 795.606,69 ha pada proyeksi peta UTM 49 Southern Hemisphere 1984

dengan datum global WGS84. Secara geografi wilayah kajian terletak antara

07º43’26” sampai 08º26’55,4” LS dan  111º23’32,3” sampai 112º57’34,2” BT.

Gambar 3.1 Daerah Studi Wilayah UPT PSDA Malang
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3.1.2 Cakupan Wilayah Penelitian

Cakupan wilayah penelitian meliputi Kabupaten Malang kecuali Kecamatan

Lebakharjo, Dampit, Ampelgading, dan Lawang; Blitar; Tulungagung; dan

Trenggalek.

3.2 Alat dan Bahan Penelitian

3.2.1 Alat

Alat yang digunakan dalam penelitian ini antara lain sebagai berikut:

a. Seperangkat personal computer (PC)

Fungsi dari komputer sebagai media kerja untuk memasukkan, mengolah,

dan menampilkan data hasil penelitian;

b. Software ArcGIS

Fungsi dari software ini sebagai platform operasional, penyusunan, dan

editing layer;

c. Microsoft Excel 2007

Fungsi program ini untuk memasukkan, mengolah, dan memperbaiki data.

3.2.2 Bahan

Bahan yang digunakan dalam penelitian ini berupa data sekunder antara

lain sebagai berikut:

a. Data curah hujan harian (times series) 10 tahun periode (2001 – 2010)

untuk menentukan faktor R;

b. Peta sebaran stasiun hujan untuk menentukan sebaran faktor R;

c. Peta jenis tanah untuk faktor menentukan faktor K;

d. Peta tataguna lahan untuk menentukan faktor CP;

e. Data DEM dengan resolusi 30 x 30 m untuk menentukan faktor LS;

f. Data titik kontrol menggunakan GPS untuk penentuan secara kualitatif.
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3.3 Prosedur Penelitian

Prosedur penelitian ini digambarkan pada diagram alir penelitian pada

Gambar 3.2 berikut ini.

Gambar 3.2 Diagram alir prosedur pelaksanaan penelitian

13
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3.3.1 Inventarisasi Data

Data yang digunakan pada penelitian ini terdiri atas data rentang waktu (time

series) dan data spasial. Data rentang waktu terdiri atas data curah hujan harian.

Data spasial terdiri atas data atribut dan data objek. Data atribut terdiri atas data

erodibilitas tanah, data tataguna lahan, dan data erosivitas hujan yang didapat dari

hasil perhitungan, sedangkan data objek terdiri atas peta jenis tanah, peta tataguna

lahan, peta sebaran stasiun hujan, dan data DEM dengan resolusi 30 x 30 m. Data

tersebut diperoleh dari Laboratorium Teknik Pengendalian dan Konservasi

Lingkungan.

3.3.2 Pengolahan Data Curah Hujan

Pengolahan data curah hujan yaitu pengolahan data curah hujan harian

menjadi data hujan bulanan. Kemudian dicari data rata-rata curah hujan tahunan

dalam satuan mm/tahun. Pengolahan data curah hujan bertujuan menghitung nilai

erosivitas sesuai persamaan 2.2. Data hujan yang dipakai yaitu antara tahun 2001

– 2010. Metode yang digunakan untuk mengolah data curah hujan harian menjadi

rata-rata hujan tahunan yaitu metode aljabar dengan memanfaatkan program Ms.

Excel 2007. Menurut Bhavani (2013:2794) rumus perhitungan curah  hujan rata-

rata metode aljabar dituliskan pada persamaan 3.1. Persamaan tersebut dapat

digunakan untuk menghitung curah hujan rata-rata tahunan, namun koefisien P

diganti dengan curah hujan bulanan, sedangkan koefisien n merupakan banyak

bulan dalam satu tahun.

= ( + + +⋯……… )................................................(3.1)

Keterangan

Pm  Curah hujan rata-rata (mm/bulan)

P  Curah hujan harian (mm/hari)

n  Banyak hari dalam satu bulan
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3.3.3 Input Layer GIS dan Data Atribut

Input layer-layer GIS  yang sudah ada yaitu layer sebaran stasiun hujan, layer

jenis tanah, data DEM dan layer tataguna lahan. Semua layer yang diinput masih

dalam format vektor kecuali layer DEM yang telah dalam format raster.

a. Data curah hujan tahunan hasil pengolahan, diinput sebagai data atribut

pada layer stasiun hujan untuk setiap stasiun hujan dengan cara

menambahkan field baru pada Open Attribute Table. Layer peta ini

nantinya digunakan untuk membuat peta distribusi faktor R.

b. Nilai K yang diperoleh dari Tabel 2.1 diinput pada layer peta jenis tanah.

Dengan cara yang sama yaitu menambahkan field baru pada Open

Attribute Table. Layer ini nantinya digunakan untuk membuat peta faktor

K.

c. Data DEM resolusi 30 x 30 m direpresentasikan dalam jendela kerja

ArcGIS dengan menu Add data. Data ini nantinya digunakan untuk

mencari dan membuat peta faktor LS.

d. Nilai CP yang diperoleh dari Tabel 3.1 diinput pula sebagai data atribut

layer tataguna lahan dengan cara yang sama. Layer ini digunakan sebagai

dasar membuat peta faktor CP.

3.3.4 Pengolahan Layer GIS

Pengolahan setiap empat layer dilakukan untuk menghasilkan empat layer

faktor erosi. Hal ini dilakukan dengan tujuan mengkonversi layer stasiun hujan,

jenis tanah, dan tataguna lahan yang awalnya  dalam format vektor menjadi

format raster dengan resolusi 30 m kecuali data DEM yang telah dalam format

raster. Penyeragaman resolusi faktor R, K, dan CP disesuaikan dengan resolusi

DEM. Hal ini bertujuan agar nilai yang terkandung di dalam piksel dapat

teridentifikasi ketika semua layer dioverlay sehingga output yang dihasilkan

bernilai. Dengan kata lain output tidak “no value”. Pengolahan empat layer akan

menghasilkan peta faktor-faktor erosi.

16
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a. Faktor R

Nilai R dihitung menggunakan persamaan 2.2 dengan memanfaatkan

program Ms. Excel 2007. Nilai tersebut diinput ke dalam layer stasiun

hujan seperti langkah pada subsubbab 3.3.3 poin a. Penyebaran atau

distribusi erosivitas hujan ditentukan menggunakan interpolasi Inverse

Distance Weighting (IDW) (Kartika, 2012:24). Ouput hasil interpolasi

berupa layer faktor R berformat raster dengan resolusi 30 m. Kemudian

layer tersebut diclip menggunakan peta region UPT PSDA Malang.

Tabel 3.1 Nilai faktor CP di DAS Brantas

No Jenis Tataguna Lahan Nilai CP

1 Pemukiman 1
2 Rawa/Hutan Rawa 0,01
3 Empang 0,001
4 Pabrik/Bangunan 1
5 Bandar Udara/Pelabuhan 1
6 Penggaraman 1
7 Sungai 0,001
8 Pasir 1
9 Danau/Bendungan 0,001
10 Tanah kosong/Padang rumput 0,02
11 Semak belukar 0,1
12 Sawah irigasi 0,02
13 Sawah tadah hujan 0,05
14 Hutan 0,001
15 Kebun 0,3
16 Ladang 0,28

(Sumber: Bappenas, 2012:20)

b. Faktor K

Layer jenis tanah yang telah diinput dengan nilai K untuk setiap jenis

tanah yang semula dalam format vektor dikonversi menjadi format raster

menggunakan menu Toolbox Conversion Tools > Polygon to Raster untuk

menghasilkan layer faktor K dengan resolusi 30 m.
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c. Faktor LS

Data DEM diolah dalam dua tahap untuk menghitung faktor LS. Pertama,

data DEM diolah menjadi slope dalam bentuk derajat menggunakan menu

Spatial Analyst Tools > Surface > Slope. Kedua, data DEM diolah untuk

menentukan flowaccumulation atau jumlah aliran untuk setiap cell

menggunakan menu Spatial Analyst Tools > Hydrology >

Flowaccumulation. Selanjutnya, nilai LS dihitung dengan persamaan 2.3

menggunakan Raster Calculator. Penulisan persamaan LS di dalam Raster

Calculator seperti berikut ini.

LS=Power("facc"*30/22.13,0.4)*Power(Sin("slope")/0.0896,1.3) .....(3.2)

d. Seperti halnya faktor K, layer jenis tanah yang telah diinput dengan nilai

CP untuk setiap jenis tataguna lahan yang semula dalam format vektor

dikonversi menjadi format raster menggunakan menu Toolbox Conversion

Tools > Polygon to Raster untuk menghasilkan layer faktor CP resolusi 30

m.

3.3.5 Penggabungan Layer GIS

Semua layer faktor penyebab erosi dioverlay. Penentuan besarnya prediksi

erosi dilakukan dengan mengalikan empat faktor erosi yaitu R, K, LS, CP dengan

menggunakan Raster Calculator sesuai dengan persamaan 2.1. Ouput yang

dihasilkan berupa layer peta laju erosi dengan satuan ton/tahun.

3.3.6 Klasifikasi

Layer erosi yang sudah dihasilkan kemudian diklasifikasikan sesuai dengan

tingkat erosi sangat ringan, ringan, erosi sedang, erosi berat dan erosi sangat berat

sesuai Tabel 2.3.
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3.3.7 Pembuatan Layout Peta Tingkat Bahaya Erosi

Pembuatan layout peta tingkat bahaya erosi ini dibuat setelah proses

klasifikasi. Langkah yang perlu dilakukan yaitu mengaktifkan Layout view pada

Toolbar View untuk menampilkan peta tingkat bahaya erosi dalam layout. Layout

perlu ditambahkan elemen-elemen peta seperti judul, legenda, skala, grid, dan

arah mata angin melalui Toolbar Insert pada jendela ArcGIS. Setelah penambahan

elemen-elemen peta ditambahkan, peta disimpan, kemudian diekspor melalui

Toolbar File > Export untuk menghasilkan peta berformat .jpg.
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